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Werken met FrontPage 2003 (Engelse versie) 
 Versie 1.0, 13 juli 2007 

Voor wie is deze handleiding? 
Deze handleiding is bedoeld voor gebruikers van FrontPage 2003 die geen of weinig 
ervaring met dit programma hebben.  Het is vooral gericht op het snel kunnen 
aanpassen en publiceren van webpagina’s.  We behandelen dan ook vooral die 
onderwerpen die daarop betrekking hebben. 

De handleiding gaat uitdrukkelijk niet over complexe opmaak, of zelfs maar over HTML.  
We behandelen ook lang niet alle onderdelen van FrontPage.  Wilt u zich verdiepen in 
dergelijke zaken, dan kunt u het beste eens rondkijken op de informatica-afdeling van 
een boekhandel.  Er zijn diverse, zeer uitgebreide, handleidingen voor FrontPage 
verkrijgbaar. 

Korte beschrijving van de inhoud 
Het hoofdstuk ‘Stappenlijst: pagina aanpassen en publiceren’ (pagina 2) is bedoeld als een 
snel recept voor het publiceren van pagina’s.  U kunt dit hoofdstuk raadplegen als u al 
enigszins bekend bent met FrontPage.  Het wordt als eerste hoofdstuk aangeboden 
zodat u er snel op terug kunt vallen. 

Het hoofdstuk ‘Overzicht van het programma’ (pagina 3) geeft een meer uitgebreide 
rondleiding door het programma FrontPage.  Dit hoofdstuk is geschikt als eerste 
kennismaking met het programma. 

Het hoofdstuk ‘Een webpagina bewerken’ (pagina 8) vertelt hoe u een pagina kunt 
maken, bewerken, teksten uit andere bronnen kunt invoegen, hyperlinks kunt maken en 
plaatjes kunt invoegen. 

Het hoofdstuk ‘Diverse handelingen’ (pagina 13) gaat nog wat dieper in op een aantal 
technieken.  U hebt deze kennis niet echt nodig om een pagina te bewerken of te 
publiceren.  Het kan wel van pas komen als u een (complex) web moet beheren. 

Het hoofdstuk ‘Handige tools, tips en trucs’ (pagina 16) geeft wat nuttige wenken in het 
gebruik van FrontPage. 

Het hoofdstuk ‘Achtergrond: opzet van de webservices’ (pagina 19) geeft 
achtergrondinformatie over de opzet en werking van websites.  U hebt deze kennis niet 
nodig bij het onderhouden en publiceren van pagina’s.  Het kan echter helpen als u enig 
begrip heeft van de werking van een website. 

Hoe geven we dingen aan? 
In deze handleiding wordt vaak verwezen naar dingen die u op het scherm ziet of moet 
doen.  Om een goed onderscheid te kunnen maken tussen de verschillende onderdelen, 
wordt de tekst steeds op een bepaalde manier gepresenteerd: 

• Alles wat het programma zelf op het scherm zet in de vorm van menu’s, 
dialoogvensters, opties enzovoort, wordt aangegeven in een ander lettertype met 
een andere kleur.  Een ‘>’ geeft aan dat u een (sub)menu moet openen.  
Bijvoorbeeld: Menu: File > Open Site… opent het dialoogvenster Open Site. 

• Voorbeelden van tekst die u in moet vullen zetten we tussen dubbele 
aanhalingstekens.  De naam van de site die u op moet geven zou bijvoorbeeld 
“http://www.science.uu.nl/mijnweb” kunnen zijn.  Als er in zo’n tekst iets vet 
staat weergegeven, moet u op die plaats zelfs iets invullen. 

• Als u een toets of toetsencombinatie moet gebruiken om iets te doen, dan 
geven we dat aan tussen punthaken.  Bijvoorbeeld: om een bestand op te slaan 
gebruikt u <Ctrl-S> (de toetscombinatie ‘Ctrl’ en ‘S’). 

• Als u de PDF-versie van deze handleiding heeft, dan kunt op blauwe tekst 
klikken: u springt dan naar het betreffende onderwerp toe. 
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Stappenlijst: pagina aanpassen en publiceren 
In dit hoofdstuk noemen we alleen de stappen die u volgt als u een website moet 
aanpassen en publiceren.  Wel verwijzen we steeds naar de uitgebreidere uitleg elders in 
dit document.  Teksten die cursief staan zijn bedoeld voor ‘gevorderden’: dit zijn 
handelingen die iets ingewikkelder kunnen zijn. 
 

Website openen  

 Vanuit FrontPage: Menu: File > Open Site… 
 of met icoon van website 

pagina 3 
pagina 16

Pagina(’s) aanpassen  

 Open een pagina in de Folder List met dubbelklikken pagina 8
 Gebruik alleen eenvoudige opmaak: 

vet <Ctrl-B>, cursief <Ctrl-I>, 
lijsten, kantlijn inspringen, uitlijnen 

pagina 8

 Gebruik Menu: Edit > Paste Special… voor tekst uit andere bronnen 
 of gebruik sneltoets <Alt-S> of knop voor paste special 

pagina 9 
pagina 17

 Hyperlinks invoegen/bewerken: selecteer tekst en 
gebruik Menu: Insert > Hyperlink… 
of sneltoets <Ctrl-K> of knop Insert Hyperlink 
 of de ‘snelle’ methode 
Let op het frame waarin een link wordt geopend 

pagina 9 
 
 
pagina 18 
pagina 10

 Plaatjes invoegen/bewerken: dubbelklik op het plaatje als het in 
de pagina staat 
 let op soort en grootte van het plaatje 

pagina 11 
 
pagina 18

 Sla uw werk op met Menu: File > Save 
of sneltoets <Ctrl-S> of knop Save

pagina 12

Nieuwe pagina’s maken  

 Maak een nieuwe pagina aan 
of kopieer een bestaande pagina: Cut <Ctrl-C> en Paste <Ctrl-V> 
 let op bij het kopiëren van framepagina’s 

pagina 11 
pagina 11 
pagina 15

 Sla uw werk op met Menu: File > Save 
of sneltoets <Ctrl-S> of knop Save

pagina 12

Controleer de website op de ontwikkelserver  

 Kloppen de links? 
Staan de plaatjes er goed op? 
Zijn de teksten wel in orde? 
Is het algemene beeld in orde? 

pagina 12

Publiceer de website  

 Open de tab Remote Website 
 zet eventueel eerst de Remote Web site op 

pagina 5 
pagina 5

 Publiceer de website 
 of publiceer afzonderlijke pagina’s 

pagina 5 
pagina 13

Controleer de website op de webserver  

 Kloppen de links? 
Staan de plaatjes er goed op? 
Zijn de teksten wel in orde? 
Is het algemene beeld in orde? 

pagina 12
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Overzicht van het programma 

FrontPage openen 
Wanneer u het programma FrontPage opent, 
wordt meestal de website geopend die u als 
laatste heeft afgesloten.  Als dat niet het geval is, 
of als u een andere website wilt openen, dan kunt 
u dat doen via Menu: File > Open Site…  In het 
dialoogvenster (zie afbeelding ) vult u bij Site 
name het volledige adres in van de gewenste 
website.  Als u de betreffende site al eens eerder 
geopend heeft, is het adres waarschijnlijk ook al 
beschikbaar onder My Network Places: klik op de 
betreffende knop aan de linkerkant van het d
geselecteerd als u dit dialoogvenster opent).  Zoek de betreffende website in de lijst en 
selecteer deze.  Let wel goed op dat u de site op de juiste server selecteert! 

Klik tenslotte op 

ialoogvenster (meestal is deze al 

een wordt u gevraagd om in te loggen.  Als er geen 

aakt. 

Het hoofdscherm 
 in een aantal onderdelen (zie afbeelding ).  Welke 

 PC. 

Open.  In het algem
netwerkproblemen zijn, wordt uw website nu geopend in FrontPage.  Meestal wordt 
ook meteen de beginpagina van de website geladen in het hoofdscherm. 

Op pagina 16 wordt uitgelegd hoe u een snelkoppeling naar uw website m

Het hoofdscherm valt uiteen
onderdelen er wel of niet zichtbaar zijn is afhankelijk van instellingen op de eigen

 
Bovenin het scherm zitten de menubalk en diverse knoppenbalken (1). 

rzicht biedt over 

f 
via de snelknop <Alt-F1> . 

Aan de linkerzijde van het scherm is de folder list te zien (2), die een ove
de gehele site.  Als de folder list niet zichtbaar is, dan kan deze geopend worden met 
behulp van de knop Toggle Pane in de knoppenbalk (A), of via Menu: View > Folder List, o
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Het rechterdeel van het scherm kan voor allerlei zaken worden gebruikt.  In de 
afbeelding is een pagina geopend om te bewerken.  Het bewerkingsscherm is 

e-view 
iew 

r 

  

 

pstarten van 
er aan 
ie 

s 
Deze tab geeft een overzicht van de website, verg

het FrontPage-scherm. 

Via deze tab krijgt men toegang tot de Remote web site, dat is de website waar 
rt (zie ook pagina 20).  Deze website moet dan 

anieren 

g Click “Remote Web Site Properties…” to set up a remote web site.  Zie ‘Remote 

emote web site beheren en publiceren’ 

Deze tab geeft een lijst met rapporten.  Dat zijn overzichten met gegevens over de 
t hier bijvoorbeeld een lijst met alle bestanden in de website en een lijst 

hoe 

Deze tab toont hoe de pagina’s binnen de website met elkaar zijn verbonden door 
 view Hyperlinks’ (pagina 6), waar wordt uitgelegd hoe u de 

Met Tab: Navigation kunt u een navigatiestructuur in uw site maken.  De Tab: Tasks is 
rdere personen wordt beheerd.  Zij vallen echter 

opgedeeld in twee stukken: een code-view (3) en een design-view (4).  In de cod
wordt de HTML-code getoond waaruit de pagina is opgebouwd.  In de design-v
wordt de pagina getoond zoals die er bij benadering in een webbrowser uit zal zien. 

De verschillende instellingen kunnen worden gemaakt met behulp van de tabs onde
aan het scherm (B).  Hier geeft de optie Split de opzet die in de afbeelding staat.  Met 
Design en Code wordt gekozen voor respectievelijk alleen de design-view of code-view.
Met Preview wordt de pagina getoond zoals die er werkelijk uitziet in een browser; de 
pagina kan in deze view niet worden bewerkt. 

Boven aan het bewerkingscherm zijn tabs 
zichtbaar (C).  Als er meerdere pagina’s zijn 
geopend om te bewerken, worden die hier
eveneens als tab getoond. 

De meest linkse tab, Web Site, toont een 
algemene view, die bij het o
FrontPage gelijk is aan de folder list.  Ond
deze view ziet u de overige view-opties  (z
afbeelding ).  Deze opties worden hieronder 
behandeld. 

Tab: Folder
elijkbaar met de folder list aan de 

linkerzijde van 

Tab: Remote Web site 

FrontPage materiaal naar toe publicee
wel bekend zijn.  Als deze tab wordt geopend, kan FrontPage op verschillende m
reageren. 

Als de Remote web site nog niet bekend is, toont FrontPage een leeg scherm met de 
mededelin
web site opzetten’ (pagina 5) voor details. 
Als de Remote web site wel bekend is, wordt het scherm verder gesplitst en kunt u 
publiceren naar de Remote web site.  Zie ‘R
(pagina 5) voor details. 

Tab: Reports 

website.  U vind
met alle links in de website.  Zie ‘De view Reports’ (pagina 7), waar wordt uitgelegd 
u Reports kunt gebruiken om de website te verbeteren. 

Tab: Hyperlinks 

hyperlinks.  Zie ‘De
Hyperlinks-view kunt gebruiken om de website te verbeteren. 

Tab: Navigation   en   Tab: Tasks 

vooral handig als de website door mee
buiten het bereik van deze handleiding, en worden daarom niet verder toegelicht. 
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Remote web site opzetten 
t u de view Remote 

ote 

 
 type 

 

e 
ellingen: de optie Publish moet op 

 

gen 

e
op uw PC.  U kunt ze te allen tijde wijzigen.   

ite opzetten’ hierboven), 
ite.  Het kan zijn dat u 

Om de Remote web site op te zetten, open
Web site via de tab of via Menu: View > Rem
Web Site.  Rechts boven de view vindt u nu de 
knop Remote Web Site Properties…  Klik hierop 
en u krijgt een dialoogvenster te zien (zie
afbeelding ).  Onder Remote Web server
selecteert u de optie FrontPage or SharePoint 
Services.  In het invoerveld Remote Web site 
location vult u het volledige adres in van de 
website waar naar toe gepubliceerd moet 
worden.  Als u dit adres niet weet, neem dan
contact op met de beheerders. 

Open nu de tab Publishing en controleer d
volgende inst
Changed pages only staan, de optie Changes 
moet op Determine changes by comparing source
and destination sites staan, en de optie Log 
changes during publish moet aangevinkt zijn. 

Klik op OK om deze instellingen vast te leg
(u wordt gevraagd om in te loggen).  Deze 
instellingen worden per website door FrontPag
dus per website maar één keer in te voeren 

Remote web site beheren en publiceren 

 vastgelegd en onthouden.  U hoeft ze 

Wanneer er een Remote web site is opgezet (zie ‘Remote web s
kunt u deze openen via de tab of via Menu: View > Remote Web S
moet inloggen.  De view is opgedeeld in drie velden (zie afbeelding ). 

 
Het linker bovenveld (1) toont de Local web site, oftewel het web dat aanvankelijk in 
FrontPage werd geopend.  Het rechter bovenveld (2) toont de Remote web site, oftewel 
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het web waar naar toe gepubliceerd wordt.  In beide gevallen wordt ook het 
internetadres getoond, zodat u kunt controleren of u naar de juiste websites kijkt. 
Het onderste veld (3) is het statusscherm.  Hier kunt u de wijze van publiceren 
specificeren (A).  De standaard publicatiemethode is Local to remote, dat wil zeggen 

nader 
dat 

e 

erm te vinden (B).  U vindt hier links om de log-file 

ijn: 

de bestanden van het in FrontPage geopende web worden gepubliceerd naar de 
Remote web site.  De optie Remote to local doet precies het omgekeerde.  Met Synchroniz
wordt er beide kanten op gewerkt. 

Om te publiceren klikt u op de knop Publish Web site.  Informatie over de meest recente 
publiceeractie is ook in het statussch
te bekijken (daarin is precies terug te vinden welke bestanden zijn gekopieerd), om de 
gepubliceerde website met behulp van een browser te bekijken, en om de Remote web 
site te openen in FrontPage. 

Het is mogelijk om alleen specifieke bestanden te laten zien.  Dit stelt u in met de optie 
View (C).  De mogelijkheden z

• Folder Contents: toont alle bestanden in de website (dit is de standaard). 

• Files to publish: laat alleen die bestanden zien die voor publicatie in aanmerking 
komen.  Welke bestanden dat zijn hangt af van de ingestelde 
publicatiemethode (zie hierboven).  Bestanden die gepubliceerd moeten 
worden zijn te herkennen aan een blauw pijltje  voor de bestandsnaam. 

• 

 
andsnaam.  Hoe 

n 

• 
nneer er gepubliceerd wordt.  Welke problemen, en hoe ze op te 

Met beh lijk snel 
enkele b  in plaats van de gehele website.  U kunt daarvoor 

l zien 
sen de 

naar 

staande pagina, 
en 

 
t een 

erde bestand verwijst, zelf ook weer verwijzen 
et een klein plus-tekentje.  Door 

 

Files not to publish: laat alleen bestanden zien die niet gepubliceerd mogen 
worden.  Welke bestanden dat zijn hangt af van de ingestelde 
publicatiemethode (zie hierboven).  Bestanden die niet gepubliceerd mogen
worden zijn te herkennen aan een rood kruisje       voor de best
u een bestand tegen publiceren kunt beveiligen (of deze beveiliging ongedaa
kunt maken) wordt in beschreven in ‘Bestanden beveiligen tegen publiceren’ 
(pagina 13). 

Files in conflict: laat alleen bestanden zien die een probleem zouden kunnen 
opleveren wa
lossen, wordt beschreven in ‘Problemen oplossen die bij het publiceren 
optreden’ (pagina 13). 
ulp van de pijlknoppen tussen de twee bovenvelden (D) is het ook moge
estanden te publiceren

bestanden selecteren in zowel de local als de remote web site.  De betekenis van de 
pijlknoppen vindt u in het statusscherm onder (A). 

De view Hyperlinks 
In de view Hyperlinks kunt u sne
welke verbanden er bestaan tus
pagina’s in uw web (afbeelding ). 

Selecteer in de Folder List een pagina.  
Deze wordt in het midden van de 
hyperlinks-view getoond.  Met pijltjes 
wordt aangegeven welke pagina’s 
de geselecteerde pagina verwijzen, en 
naar welke pagina’s de geselecteerde 
pagina zelf verwijst. 
Als een link verwijst naar een 
onbekende of niet-be
dan wordt dat getoond door e
gebroken pijl.  Een verwijzing naar een
e-mailadres wordt aangegeven me

Als de bestanden waarnaar het geselecte
naar andere bestanden, dan wordt dit aangegeven m

brief-icoon. 

op dit plusje te klikken, worden ook deze verwijzingen getoond.  Het plusje verandert in
een min-teken, waarmee u de getoonde verwijzingen weer kunt verbergen. 
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U kunt de ‘focus’ van de hyperlink-view veranderen door een ander bestand te kiezen in 
de Folder List.  U kunt de focus ook direct leggen bij één van de bestanden in de 

en van 

‘Hyperlinks controleren’ (pagina 14); voor het herberekenen van 

eoverzicht van uw website (afbeelding ).  Deze 
andig zijn bij het beheren van uw site en het vinden van 

hyperlink-view.  Rechtsklik op het bewuste bestand en kies de optie Move to Center.  Het 
gekozen bestand wordt nu in het midden van de view geplaatst, en de links naar 
dit bestand worden getoond. 
Door op een bestand te dubbelklikken kunt u het betreffende bestand openen in het 
bewerkingsscherm. 
In een enkel geval worden links niet juist weergegeven.  Voor de controle van 
‘gebroken’ links, zie 
links, zie ‘Hyperlinks herberekenen’ (pagina 15). 

De view Reports 
Deze view geeft een rapportag
rapportages kunnen heel h
problemen. 

 
Onder het menu Site Summary (A) vindt u alle rapporten, ook die welke niet in de 
algemene view worden getoond.  We zullen hier niet in detail ingaan op alle rapporten.

n via 

hoe groot bestanden zijn, door wie ze het laatst gewijzigd zijn, 

De rapp
snel zien of en welke hyperlinks er niet goed werken.  Voor de 

erlinks controleren’ (pagina 14); voor het 

Compon
oed werken, 

 hier terugvinden. 
 

  
Heel handig zijn de volgende rapporten.  Rapporten met een * zijn alleen te vinde
het menu Site Summary. 

All Files   en   Recently changed files*: 

Hier kunt u zien 
enzovoort. 

orten met betrekking tot Hyperlinks: 
Hier kunt u 
controle van ‘gebroken’ links, zie ‘Hyp
herberekenen van links, zie ‘Hyperlinks herberekenen’ (pagina 15). 

ent errors: 
Als u gebruik heeft gemaakt van FrontPage-componenten die niet g
kunt u dat

Roelof Ruules, R.A.Ruules@uu.nl    versie 1.0, 13 juli 2007 



Werken met FrontPage 2003 (Engelse versie)  8/22 

Een webpagina bewerken 
In dit hoofdstuk vertellen we hoe u een webpagina kunt bewerken.  We gaan er van uit 
dat u daarbij werkt in de design-view (zie pagina 3), tenzij anders is aangegeven.  We 
leggen eerst uit hoe u bestaande pagina’s aanpast. 

U opent een bestaande pagina in het bewerkingsscherm door er in de Folder List op te 
dubbelklikken. 

Eenvoudige opmaak 
FrontPage beschikt over allerhande manieren om uw tekst op te maken.  Bovenin het 
hoofdscherm vindt u opmaakknoppen die u ook in andere Office-pakketten aantreft.  
Onder het menu Format vindt u nog uitgebreidere mogelijkheden. 
Toch is het verstandig om de opmaak tot een minimum te beperken.  De opmaak van 
pagina’s op de sites van Bètawetenschappen wordt namelijk veelal vastgelegd in 
zogenaamde stylesheets (zie ook ‘Stylesheets’, pagina 21).  Opmaak die u zelf aanbrengt 
kan daarmee in conflict zijn, of ongewenste gevolgen hebben. 
Tekst die u uit een ander bestand kopieert en invoegt kan ook aanleiding geven tot 
problemen.  In de sectie ‘Tekst uit andere bronnen invoegen’ (pagina 9) leggen we uit 
hoe u hiermee om kunt gaan. 

Als u heel specifieke opmaak in uw pagina’s wilt gebruiken, en u weet niet hoe u dit 
met behulp van een stylesheet zou moeten vastleggen, neem dan contact op met 
facultaire beheerders van de webserver waarop uw site staat. 

Opmaak die u altijd zonder problemen kunt gebruiken 
• Vet en cursief: hiervoor kunt u de sneltoetsen <Ctrl-B> en <Ctrl-I> 

gebruiken (voor Bold en Italic), of de knoppen op de knoppenbalk. 

• Lijsten maken: hiervoor kunt u de knoppen op de knoppenbalk 
gebruiken; u kunt kiezen uit genummerde lijsten en ‘bullet’-lijsten. 

• Kantlijn inspringen: hiervoor kunt u de knoppen op de 
knoppenbalk gebruiken; u kunt de tekst in stappen laten inspringen 
of de indentering ongedaan maken. 

• Tekst uitlijnen: hiervoor kunt u de knoppen op de 
knoppenbalk gebruiken; u kunt de tekst links uitlijnen, 
centreren, rechts uitlijnen, of aan beide zijden uitlijnen.  
Deze laatste optie wordt niet altijd correct weergegeven in oudere browsers. 

Opmaak die u beter niet kunt gebruiken 
• Onderstrepen: onderstreepte tekst kan tot verwarring leiden, omdat 

onderstreping op webpagina’s ook wordt gebruikt om hyperlinks aan te geven. 

• Lettergrootte en lettertype (font): gebruik bij voorkeur altijd het ‘standaard’ 
lettertype.  Andere lettertypen of -grootte kunnen problemen opleveren, vooral 
bij bezoekers die uw website bekijken op een ander systeem dan Windows.  Als 
u toch een ander lettertype wilt gebruiken, neem dan even contact op met de 
beheerder van de webserver. 

• Kleuren: wees spaarzaam in het gebruik van andere kleuren dan de standaard.  
Gebruik in ieder geval geen andere kleuren voor uw lettertype. 

• Alineaopmaak: deze kan het best vastgelegd worden in een stylesheet, niet via 
de menu-opties die FrontPage hiervoor biedt. 
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Tekst uit andere bronnen invoegen 
it een 

ser, 

ral teksten die zijn opgemaakt in Word 
en. 
dere bron, dan kunt u 

onkelijke tekst. 

 
e 

, kan het handig zijn om 
van Paste Special een knop en een sneltoets te maken.  In het hoofdstukje ‘Paste 

legd hoe u dit kunt 

Hy e
Met hy  o id 
tussen agina’s op uw
web te
Om een u de tekst die als hyperlink moet gaan 
wer n e sneltoets <Ctrl-K>, of 
geb ik et dia rt 
Hyperlin
dat in d
de optie 

Een
Het eenvoud
ven
waar u
FrontPa
hyperli
verschij
gev
hyperli
doo  
pagina.  In die folder moet wel een bestand met de naam 

en externe link 
Page biedt in het dialoogvenster de optie Browse the Web.  Deze levert echter nog 

el eens problemen op.  Het is beter om met een webbrowser eerst de website of 
agina op te zoeken waar u naartoe wilt linken.  Kopieer vervolgens uit de adresbalk 

Teksten die u met knippen-plakken overneemt u
ander bestand, bevatten vaak opmaak die niet wenselijk 
is in een webpagina.  De pagina kan er op uw PC dan 
wel goed uitzien, maar iemand met een andere brow
of een ander platform dan Windows, kan grote 
problemen hebben om uw pagina te lezen of zelfs maar 
te bekijken.  Voo
kunnen grote problemen oplever
Als u tekst wilt plakken uit een an
het best gebruik maken van de optie Menu: Edit > Paste 
Special…  U krijgt een dialoogvenster te zien met een 
aantal mogelijkheden (zie afbeelding ).  Kies hier voor 
de optie Normal paragraphs of voor de optie Normal 
paragraphs with line breaks.  In beide gevallen wordt de 
tekst ontdaan van alle opmaak, maar in het laatste geval 
worden wel harde en zachte returns overgenomen uit de oorspr

Bij deze methode verdwijnt wel alle oorspronkelijke opmaak, dus ook vet en cursief. 
Het kan dus betekenen dat u de tekst in uw webpagina nog moet nabewerken om dez
opmaak te herstellen. 

Tips 
• Als u vaak teksten moet overnemen uit andere bronnen

Special als knop en als sneltoets’ (pagina 17) wordt uitge
doen. 

p rlinks aanbrengen en beheren 
perlinks knoopt u uw bestanden als het ware aan elkaar.  We maken ndersche
interne en externe hyperlinks: de eerste verwijzen naar p

si , de laatste naar pagina’s daarbuiten. 
 hyperlink aan te brengen, selecteert 

 eigen 

ke .  Ga nu naar Menu: Insert > Hyperlink…, of gebruik d
ru  de knop Insert Hyperlink op de knoppenbalk.  Dit opent h

k (zie afbeelding ).  Zorg 
it venster in de linker kolom 

Existing File or Web Page is 

loogvenster Inse

geselecteerd. 

 interne link 
igst is het om in het 

ster (1) de pagina op te zoeken 
 naartoe wilt linken.  
ge zorgt er voor dat de juiste 

nk in het veld Address 
nt.  Als u de juiste plek 

onden heeft klikt u op OK.  De 
nk wordt aangebracht op de 

r u geselecteerde tekst.  U kunt ook naar een folder linken, in plaats van naar een 
index.html of default.htm staan. 

E
Front
w
p

Roelof Ruules, R.A.Ruules@uu.nl    versie 1.0, 13 juli 2007 



Werken met FrontPage 2003 (Engelse versie)  10/22 

van uw webbrowser het complete adres (dus inclusief het stuk “http://”) en plak dit in 

) In de meeste 
 om de nieuwe pagina in een 
venster Insert Hyperlink doen 

ntal mogelijkheden: 

 voor de pagina is gedefinieerd waarin de 
 de volgende opties. 

n hetzelfde frame als de pagina 
 zich in een framepagina bevindt, 

tbaar.  Bij Target Setting 
ore _). 

n het volledige scherm van de 

t 

cherm).  De oude pagina blijft zichtbaar in het oorspronkelijke 
browserscherm.  Dit is de optie “_blank”. Bij Target Setting verschijnt de tekst 
“_blank” (let op de underscore _). 

• tting: U kunt ook zelf de naam van een frame opgeven.   Het is vooral 
ebsite van Bètawetenschappen 

de manier aangebracht als een gewone 
oor 

 hier 

 e-m
s. 

assen of verwijderen 
 link wilt aanpassen, plaatst u de cursor ergens in de tekst die als link 

t dialoogvenster via Menu: Insert > Hyperlink…, of gebruik de sneltoets 
e knoppenbalk.  U kunt nu het adres waar de link naar 

 maken van het venster in het dialoogscherm om 
aan te wijzen. 

k kunt de hyperlink verwijderen. 

aangepast worden naar de nieuwe naam.  Ook als u bestanden 
orden de links daar naartoe aangepast. 

het veld Address.  Klik op OK om de hyperlink aan te brengen. 

In welk frame opent de link? 
(Zie ‘Frames’, pagina 19, voor uitleg over frames.
hyperlink correct werken.  Soms is het echter noodzakelijk
specifiek frame te laten openen.  Dit kunt u in het dialoog
met de knop Target Frame…  U kunt hier kiezen uit een aa

• Page Default: De standaard die

gevallen zal een 

hyperlink wordt opgenomen.  Dit is altijd één van

• Same Frame: De nieuwe pagina wordt geopend i
waarin de hyperlink staat.  Als de oude pagina
dan blijft de rest van die framepagina dus wel zich
verschijnt de tekst “_self” (let op de undersc

• Whole Page: De nieuwe pagina wordt geopend i
browser.  De oude pagina verdwijnt uit beeld, evenals een eventuele 
framepagina waar de oude pagina onderdeel van is.  Bij Target Setting verschijn
de tekst “_top” (let op de underscore _). 

• New Window: De nieuwe pagina wordt geopend in een nieuwe browser (of een 
nieuw browsers

• Parent Frame: Deze optie vergt een dieper begrip van hoe framepagina’s zijn 
opgebouwd.  Het voert te ver om hier nu op in te gaan, maar in de praktijk zult 
u deze optie zelden werkelijk nodig hebben. 

Target se
van belang te weten dat het hoofdframe op de w
de naam “content” heeft. 

Een link naar een e-mailadres 
Een link naar een e-mailadres wordt op dezelf
hyperlink.  In het dialoogvenster Insert Hyperlink kiest u nu echter in de linker kolom v
E-mail Address.  In het veld E-mail address vult u het gewenste adres in; FrontPage zet
automatisch de tekst “mailto:” voor, die in de HTML-code wordt ingevoegd.  Deze tekst 
moet u laten staan.  Als u al eerder
uit de lijst 

ailadressen hebt ingevoerd, kunt u deze kiezen 
Recently used e-mail addresse

Een link aanp
Als u een bestaande
werkt.  Open nu he
<Ctrl-K> of de knop Hyperlink op d
verwijst aanpassen. 

• Bij interne links kunt u gebruik
de gewenste pagina of folder 

• Met de knop Remove Lin

Tips 
• FrontPage zorgt er voor dat interne links behouden blijven.  Als u bijvoorbeeld 

een bestand een andere naam geeft, dan zullen alle interne links naar dat 
bestand ook 
verplaatst w

• Zie ook ‘Hyperlinks controleren’ (pagina 14) en 
‘
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Hyperlinks en e-mailadressen ‘snel’ invoegen’ 
(pagina 18) 

Plaatjes invoegen en beheren 

Ver lg
FrontPa
waa  
beva e
Open n
Sleep h
pag  
in d
dialoog

Op de t eelding moet worden geplaatst. 

Als i
lopen. 

Bij Align al 
spacing l witruimte (in pixels) er om de plaatjes open 
mo b

De Bord
Het is v  geven.  Dat doet u door de optie 
Spe  S
plaatje)

Op de t enster kunt u nog wat extra instellingen maken.  Van 
belang is hier vooral het veld Text: hier kunt u een tekst opgeven die verschijnt als een 

atje beweegt.  Deze tekst is ook van belang voor 
. 

 
nt dan een dik kader om het plaatje. 

 altijd het oorspronkelijke plaatje van de webserver ophalen. 

plaatje bij.  Als dat niet 
Specify size 

uit en daarna weer aan te zetten. 

Nieu
Een nie nt dan aan de rechterzijde 
van t het algemeen zult u kiezen voor 
Blank pa e, dat wil zeggen een lege pagina.  U kunt ook direct een lege pagina krijgen 
met de sneltoets <Ctrl-N> of met de knop Create a new normal page op de knoppenbalk. 

U kunt plaatjes opnemen op een webpagina.  Het is 
verstandig om de afbeeldingen eerst in een 
tekenpakket klaar te maken voor plaatsing.  Plaatjes 
moeten altijd van het type gif of jpg (jpeg) zijn.  

vo ens sleept u de plaatjes van uw PC naar 
ge.  Zet plaatjes bij voorkeur in de folder 

rin ook de pagina’s staan die de plaatjes moeten 
tt n. 

u de pagina waar u het plaatje op wilt plaatsen.  
et plaatje uit de Folder List naar de plek op de 

ina waar u het plaatje wilt plaatsen.  Als het plaatje 
e pagina staat, dubbelklikt u er op om het 

venster Picture Properties te openen (zie afbeelding ). 

ab Appearance kunt u aangeven hoe de afb

u b j Wrapping style kiest voor de opties Left of Right zal de tekst om het plaatje heen 
 Voor het beeld is dat meestal wel fraaier. 

ment kunt u de plaatsing nog wat verder specificeren.  De getallen bij Horizont
en Vertical spacing geven aan hoevee

et lijven.  Dit voorkomt dat teksten tegen het plaatje aan komen. 

er thickness kunt u het best op nul laten staan. 
erstandig om de grootte van het plaatje aan te

cify ize aan te vinken.  U kunt de grootte in een percentage (van het originele 
 opgeven, maar het is beter om deze maten in pixels aan te geven. 

ab General van het dialoogv

bezoeker met zijn muis over het pla
mensen die niet over een grafische browser beschikken, en voor visueel gehandicapten
U kunt op deze tab ook een hyperlink aanbrengen.  Het plaatje gaat dan als hyperlink 
fungeren.  Het aanbrengen van de link gaat precies zoals hierboven beschreven bij 
‘Hyperlinks aanbrengen en beheren’.  Als u een hyperlink aanbrengt is het zeker van 
belang om de Border thickness op de tab Appearance op nul te zetten.  Doet u dit niet, dan
wordt het plaatje ‘onderlijnt’: er verschij

Tips 
• Het is niet verstandig om een plaatje te ‘verkleinen’ door andere maten op te 

geven dan de werkelijke maten van het plaatje (bijvoorbeeld om een 
zogenaamde thumbnail van een grote foto te maken).  De browser moet 
namelijk nog
Het is beter om in dat geval een apart plaatje te maken met de juiste maten, en 
daar dan een hyperlink van te maken naar het oorspronkelijke plaatje. 

• In de regel houdt FrontPage zelf de juiste maten van een 
goed gaat, dan kunt de juiste instelling snel verkrijgen door de optie 

• Zie ook ‘Pas op met plaatjes’ (pagina 18). 

we pagina’s maken 
uwe pagina kunt u maken via Menu: File > New…  U ku

 he  scherm kiezen wat voor soort pagina u wilt.  In 
g
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Als u w  da
een bes a te kopiëren en aan te passen.  Selecteer een pagina in de Folder 
List, rechtsklik en selecteer Copy, selecteer de folder waar de nieuwe pagina moet 

et nieuwe bestand, rechtsklik en 

ieëren.  In de sectie 
 dieper op ingegaan. 

slaan!  Dit doet u met Menu: File > Save, 
e knoppenbalk.  Overigens 

t FrontPage altijd als u een aangepast bestand afsluit zonder op te slaan.  
erwijl u gaat publiceren krijgt u 

ssen 

ebpagina te controleren met een 

worden 
en).  Dat neemt niet weg dat het 

Zijn tekstpagina’s niet te lang, of kan een lange tekst gesplitst worden? 

Zeke  a
aangeb
tekstfo

Publi
Het b
behand
uw wer et, leest u in het hoofdstukje ‘Remote web 
site h
Een enkele keer komt FrontPage met mededelingen of foutmeldingen.  Zie ‘Problemen 

n’ (pagina 13), waar een paar van de meest-
ndeld. 

erkt met pagina’s die een vaste layout hebben,
taande pagin

n is het veel gemakkelijker om 

komen, rechtsklik en selecteer Paste.  Selecteer h
selecteer Rename, geef het bestand een nieuwe naam. 

Pas op als u deze methode gebruikt om framepagina’s te kop
‘Pagina’s met frames kopiëren’ (pagina 15) wordt hier

Opslaan 
Vergeet niet de aanpassingen in uw pagina op te 
of met de sneltoets <Ctrl-S>, of met de knop Save op d
waarschuw
Ook wanneer u aangepaste bestanden heeft openstaan t
een waarschuwing. 

Controleren 
Het klinkt misschien triviaal, maar een heel belangrijke stap in het maken of aanpa
van een webpagina is: controleren of het allemaal werkt. 

Een deel van het controlewerk kunt u door FrontPage laten doen.  Maar FrontPage is 
niet onfeilbaar.  Het beste is om een aangepaste w
webbrowser, dus buiten FrontPage om. 
De meeste websites bij Bètawetenschappen draaien op de zogenaamde stage-server.  
Dat maakt het mogelijk om de pagina’s te controleren nog voordat ze 
gepubliceerd (en dus voor ‘het publiek’ zichtbaar word
altijd verstandig is ook nog eens te controleren nadat u de website heeft gepubliceerd. 
Let bij controle in ieder geval op de volgende zaken: 

• Kloppen de links? 
Wordt bij elke link wel de juiste pagina of het juiste document geopend? 
Worden nieuwe pagina’s wel in het juiste frame of venster geopend? 

• Staan de plaatjes er goed op? 
Worden plaatjes wel goed weergegeven? 
Staan ze wel op een goede plek op de pagina? 
Duurt het laden van plaatjes niet te lang? 
Ziet u een tekst als u met uw muis over het plaatje beweegt? 

• Zijn de teksten wel in orde? 
Zijn de teksten inhoudelijk goed? 

• Is het algemene beeld in orde? 

r ls u meer dan alleen maar cosmetische wijzigingen in een website hebt 
racht, is het goed als er ook een ander naar kan kijken.  Vooral taal- en 
utjes vallen u minder op naarmate u langer met de teksten hebt gewerkt. 

ceren 
 pu liceren van de website of van specifieke webpagina’s wordt elders in meer detail 

eld.  U moet in ieder geval de Remote Web site openen, dat is de website waar u 
k naartoe publiceert.  Hoe u dat do

 be eren en publiceren’ op pagina 5. 

oplossen die bij het publiceren optrede
voorkomende meldingen worden beha
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Diverse handelingen 

Bestanden afzonderlijk publiceren 
Om allerlei redenen kan het nodig zijn om niet de website als geheel te publiceren
maar slechts een afzonderlijk bestand.  Voorbeelden: 

, 

• eel bestanden gewijzigd in de website, en die wijzigingen mogen nog 
lemaal zichtbaar zijn voor het publiek. 

 meerdere bestanden kunnen geselecteerd worden door de <Ctrl>-
en. 

 selecteer Publish Selected Files… 

gen kloppen, met name of de 

n publiceren 

tabase; de database op de Remote web site mag niet 

• iet 

Om één e beveiligen: 

• e folder list of in een Report, en 
trl>-

Don’t Publish; een rood kruisje verschijnt rechts 
. 

Om de beveiliging ongedaan te maken: 

 de 

oplossen die bij het publiceren optreden 

  De opties om verder te gaan zijn: 

Ignore and Continue: de site wordt gepubliceerd met uitzondering van de 
conflicterende bestanden. 

 Er zijn v
niet al

• Er wordt door meerdere mensen aan de website gewerkt, waardoor publicatie 
van de gehele site in één keer ongewenst is. 

Om één of meerdere bestanden te publiceren: 

• Zoek het betreffende bestand, bijvoorbeeld in de folder list of in een Report, en 
selecteer dit;
toets ingedrukt te houd

• Rechtsklik en

• Als de Remote web site nog niet was geopend, verschijnt nu het dialoogvenster 
Remote Web Site Properties; controleer of de instellin
juiste website is ingevuld (zie ook pagina 5). 

Bestanden beveiligen tege
Om allerlei redenen kan het nodig zijn om een bestand (tijdelijk) niet te publiceren, 
bijvoorbeeld: 

• De veranderingen op een pagina mogen nog niet zichtbaar worden voor het 
publiek. 

• Het bestand is een da
overschreven worden. 

Het bestand is een back-up of kopie van een ander bestand en hoeft n
gepubliceerd te worden. 
 of meerdere bestanden tegen publiceren t

Zoek het betreffende bestand, bijvoorbeeld in d
selecteer dit; meerdere bestanden kunnen geselecteerd worden door de <C
toets ingedrukt te houden. 

• Rechtsklik en selecteer de optie 
onder in de icoon van het bestand

• Selecteer het bestand of de bestanden. 

• Rechtsklik en de-selecteer de optie Don’t Publish; het kruisje verdwijnt uit
icoon. 

Problemen 
Bij het publiceren van de website kunnen er diverse problemen optreden, waarvan een 
deel eenvoudig kan worden opgelost.  Hieronder worden een paar problemen 
behandeld.  De meldteksten kunnen enigszins afwijken van de hier genoemde. 
 

Melding: Some items have changed on both the local and remote Web sites and are in conflict 
Deze foutmelding treedt op wanneer FrontPage denkt dat de betreffende 
pagina op beide websites is veranderd.
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Overwrite Remote Files: de site wordt als geheel gepubliceerd, waarbij de 
e remote  web site worden overschreven. 

er worden in het geheel geen bestanden 

estopt.  U kunt de conflicterende 

 

Meldin nged by …  

tmelding, want de publicatie 
rder te gaan zijn Yes, Yes to all, No en No 

 

Me es not exist in the current Web site … 

jn Yes, Yes to all, No en No to all, in 
de praktijk kunt u zonder problemen met Yes of Yes to all antwoorden.  Met de 

ordt herhaald. 

d bent voor deze actie, terwijl u dat wel bent 

5).  Bij voortdurende problemen kunt u contact 

U kunt 
handig  
vanuit  Reports’, pagina 7).  Selecteer het rapport Hyperlinks 
of kies  
website e links bekend is.  Deze status kan zijn: 

aar een bestaand bestand of adres. 

taand bestand of adres. 

 

Om een link te controleren selecteert u het betreffende bestand in het rapport (u kunt 
 

and, 

ogelijkheid om de link alleen in het geselecteerde bestand aan te passen, of in alle 
estanden waarin die link voorkomt, of in een selectie daarvan.  Door op de knop Edit te 

Hoewel  zich 
wel van

• rnet. 

• b kunnen alleen worden gecontroleerd 
als deze pagina’s niet zijn beveiligd met een wachtwoord. 

conflicterende bestanden op d

Cancel: de publicatie wordt gestopt en 
naar de remote web site gekopieerd. 

Bij twijfel kan de publicatie dus altijd worden g
bestanden met elkaar vergelijken door de remote web site te openen.  In de 
praktijk blijkt het vaak vals alarm te zijn. 

g: The file … on the destination server has been cha
Deze melding treedt een enkele keer op wanneer verschillende personen aan 
een website hebben gewerkt.  Het is geen fou
verloopt verder netjes.  De opties om ve
to all, in de praktijk kunt u zonder problemen met Yes of Yes to all antwoorden.  
Met de to all-opties wordt voorkomen dat de melding telkens wordt herhaald. 

lding: The file ... exists on the destination server but do
Deze melding treedt op wanneer in de lokale website een bestand (of folder) is 
verwijderd (of hernoemd).  Het is geen foutmelding, want de publicatie verloopt 
verder netjes.  De opties om verder te gaan zi

to all-opties wordt voorkomen dat de melding telkens w
 
Meldingen dat u niet geautoriseer

In het algemeen geldt dat als u de remote web site kunt openen, u ook 
geautoriseerd bent om te publiceren.  Dat u desondanks deze foutmelding krijgt 
ligt aan de webserver.  Het probleem is meestal te omzeilen door gebruik te 
maken van de pijlknoppen in de view Remote web site (zie ‘Remote web site 
beheren en publiceren’, pagina 
opnemen met de beheerders van de webserver. 

Hyperlinks controleren 
FrontPage laten controleren of de hyperlinks in uw web kloppen.  Dat is vooral 
 als u links heeft aangebracht naar pagina’s buiten uw eigen website.  Dit doet u
de reports-view (zie ‘De view
Site Summary > Problems > Hyperlinks.  U krijgt nu een overzicht van alle links in uw
.  De status geeft aan wat er van dez

• OK: de link is correct en verwijst n

• Broken: de link verwijst naar een niet-bes

• Unknown: het is niet bekend of de link verwijst naar een bestaand bestand of
adres. 

ook meerdere bestanden selecteren met behulp van de toetsen <Ctrl> of <Shift>). 
Rechtsklik en selecteer de optie Verify Hyperlink.  FrontPage zal nu de link testen. 

U kunt de betreffende hyperlink ook aanpassen.  Selecteer het betreffende best
rechtsklik en selecteer Edit Hyperlink…  De link zelf wordt getoond.  U krijgt de 
m
b
klikken, wordt de betreffende pagina in het bewerkingsscherm geopend. 

 dit een heel handig hulpmiddel is om uw hyperlinks te controleren, moet u
 een paar dingen bewust zijn: 

Uiteraard werkt deze techniek alleen als u verbinding heeft met het inte

Links naar pagina’s buiten uw eigen we
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•  werkt.  

• 
rmee klaar is. 

Hype
n een e eb ‘herberekend’ worden.  Dit kan met 
ame optreden als u de hyperlinks view gebruikt en veel wijzigingen in uw web heeft 

ik heeft gemaakt van 
bepaald
include

Ga naar
wilt uit

agina’s met frames kopiëren 

nieuwe
Als u ee
bewaar .  
(Zie ‘Fra

Stel dat  sites 
estaan doorgaans uit drie bestanden: een bestand index.html dat de frameset 

staat, e
bevat.  
gekopi
naar de
de orig

Om de 
naar de ko

epagina 
nu enkel op code-view (dus niet in split-view, zie 

Soms geeft FrontPage aan dat een link ‘broken’ is, terwijl deze wel goed
Controleer dus ook altijd even zelf of een link daadwerkelijk fout is. 

Als u meerdere pagina’s heeft geselecteerd ter controle van de hyperlinks, kan 
het even duren voordat FrontPage hie

rlinks herberekenen 
nkel geval moeten de hyperlinks in een wI

n
doorgevoerd (zie ‘De view Hyperlinks’, pagina 6).  Ook als u gebru

e FrontPage-componenten die niet goed lijken te werken, zoals tellers en 
d content, kan het nodig zijn om de actie uit te voeren. 

 Menu: Tools > Recalculate Hyperlinks…  FrontPage vraagt u of u deze bewerking 
voeren; antwoord met Yes.  

P
Als u een pagina hernoemt, dan zal FrontPage links naar die pagina aanpassen naar de 

 naam.  Ook als u een pagina verplaatst worden links naar die pagina aangepast. 
n pagina kopieert, dan blijven de links naar het oorspronkelijke bestand wel 
d.  Dat is vooral van belang om te weten als u kopieën maakt van framepagina’s
mes’, pagina 19, voor uitleg over frames.) 

 u werkt aan een website van Bètawetenschappen.  De pagina’s in deze
b
definieert, een bestand nav.html waarin de menubalk 

n een bestand cnt.html dat de echte content 
Wanneer nu deze drie bestanden worden 
eerd, dan verwijst de kopie van index.html niet 
 kopieën van cnt.html en nav.html, maar naar 
inelen.  De afbeelding  illustreert dit. 

juiste weergave te krijgen, moeten de links 
pieën worden aangebracht.  Daarvoor 

moet u de nieuwe (gekopieerde) fram
openens.  Zet het bewerkingsscherm 
ook pagina 3).  Zoek in de code alle verwijzingen naar de oorspronkelijke pagina’s en 
vervang deze door verwijzingen naar de kopieën.  In de afbeelding  staan in totaal 
drie verwijzingen die vervangen moeten worden. 
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Han

Snelkoppeling naar een website maken 
eren, kan het nuttig zijn om snelkoppelingen 
nt elke website dan snel openen door op de 

 
s en kies 

een 
t 

er m
 te 

us 
\FRONTPG.EXE” “webadres” 

ede tekst!  Ook de dubbele 

 wel inloggen. 
Als u meerdere websites hebt, kunt u de eerste icoon kopiëren en de kopie aanpassen: 
rechtsklik op de kopie en selecteer Properties; ga verder te werk als hierboven. 
 

Altijd volledige menu’s zien 
De Microsoft Office-software laat standaard niet altijd 
alle menu-opties zien.  Een paar menu-opties krijgt u 
altijd te zien (linker voorbeeld ).  De meeste opties 
worden alleen getoond als u ze heeft gebruikt, of als u 
een tijdje wacht.  De menulijst wordt dan ineens een 
stuk langer (rechter voorbeeld ).  Hierdoor kunt u 
opties over het hoofd zien die wel heel belangrijk zijn. 

U kunt aangeven dat u altijd een volledig menu te zien 
krijgt: ga naar Menu: Tools > Customize… en selecteer het 
tabblad Options.  Zet een vinkje bij de optie Always show 
full menus en klik op Close. 
Deze optie werkt door in andere Office-pakketten. 

dige tools, tips en trucs 

Vooral als u meerdere websites moet beh
naar elk van die websites te maken.  U ku
gewenste snelkoppeling te klikken.  Om een snelkoppeling te maken volgt u het 
volgende recept:  

• Open een Windows-verkenner (bijvoorbeeld via My 
Computer) en zoek op uw PC de folder “\Program 
Files\Microsoft Office\OFFICE11”; zoek in deze 
folder het programma “FRONTPG.EXE”. 

• Rechtsklik op dit bestand, houd de muisknop 
ingedrukt, en sleep het bestand naar uw
bureaublad; laat de rechtermuisknop lo
voor Create Shortcuts Here. 

• Rechtsklik op de icoon en kies voor Properties.   

• Selecteer de tab General en geef de icoon een 
logische naam, bijvoorbeeld de naam van uw 
website. 

• Selecteer de tab Shortcut. 

• In het veld Target staat het programma.  Dat is 
tekst van de vorm “C:\Program Files\Microsof
Office\OFFICE11\FRONTPG.EXE”.  Hier acht
het complete webadres van uw website komen
staan, als een aparte tekst tussen dubbele 
aanhalingstekens (zie afbeelding ).  D

oet 

“C:\Program Files\Microsoft Office\OFFICE11
Let op de spatie tussen de eerste en de twe
aanhalingstekens moet u invoeren. 
Het webadres is altijd van de vorm “http://server.uu.nl/mijnweb” 

• Klik op OK om af te sluiten. 
U kunt nu uw website openen door op de icoon te dubbelklikken.  U hoeft daarbij geen 
webadres meer in te voeren.  Uiteraard moet u nog
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Paste Special als knop en als sneltoets 
t 

loont om er een knop en een aparte sneltoets van te 

edrukt: er verschijnt een klein 
kno
een kno
Sluit he

U heeft  kunt 
nu k dialoogvenster voor Paste Special 
te open

Paste
Pas S ekst, maar tast soms ook de 
opm k eld tekst over een link heen plakt, 
gaat de maak kan op die manier 
‘verdwi  dit te voorkomen kunt u gebruik maken van de volgende truc.  
Sele ee overheen wilt plakken alles behalve het eerste en 

Het gebruik van ‘paste special’ is zo handig, dat he

maken.  Ga daarvoor als volgt te werk.  Ga naar Menu: 
Tools > Customize… en selecteer het tabblad Commands.  
Zoek onder Categories (de linkerkolom) de optie Edit en 
selecteer die.  Zoek onder Commands (de rechterkolom) 
de optie Paste Special.  Selecteer deze en houd de 
linkermuistoets ing

pje (zie afbeelding ).  Sleep deze knop ergens op 
ppenbalk, bijvoorbeeld naast de knop Paste.  

t dialoogvenster door op Close te klikken. 

 nu een knop Paste Special… gekregen.  U
oo  de toetscombinatie <Alt-S> gebruiken om het 

en. 

 Special met behoud van HTML-opmaak 
te pecial verwijdert niet alleen opmaak uit de bront

aa  van het HTML-document aan.  Als u bijvoorbe
 link verloren.  Ook cursiveringen en andere op
jnen’.  Om

ct r van de tekst waar u iets 
laat  ervolgens Paste Special om 
de u houden), en verwijder tot 
slot de 

Besta aar uw PC 
FrontPa  exporteren, bijvoorbeeld naar uw 
eigen P eerd.  
Als u sn folders 
van Win mputer.  In het algemeen staan hier al de 
website tanden uit 
wilt p lg dan het volgende recept: 

n 

• Vul onder Internet or network address het complete adres in van uw website.  Dit is 
altijd iets in de vorm “http://server.uu.nl/mijnweb”.  Klik op Next; u wordt 

e website. 

 het dialoogvenster 
lik op Next. 

 click Finish en klik op Finish. 

scherm, waarbij u eventueel 
estanden, folders of de gehele 

r uw website te kopiëren, maar 

ste letterteken: Dit is een voorbeeld-tekst.  Gebruik v
nie we tekst in te voegen (de HTML-opmaak blijft nu be

twee lettertekens van de oorspronkelijke tekst. 

nden uit een website kopiëren n
ge biedt de mogelijkheid om bestanden te
C.  Helaas kan dan steeds maar één bestand tegelijkertijd worden geëxport
el meerdere bestanden wilt exporteren, dan kunt u dat doen via de web
dows.  Deze kunt u vinden via My Co
s die u eens in FrontPage heeft geopend.  Als de website waar u bes

 ex orteren hier niet bij staat, vo

• In het scherm My Network Places vindt u aan de linkerkant onder Network Tasks de 
optie Add a network place; klik hier op en klik op Next. 

• Er zijn meerdere soorten network places; kies voor Choose another network locatio
en klik op Next. 

eventueel gevraagd in te loggen op d

• Geef een naam op voor de network place; de in
gesuggereerde naam is meestal al voldoende.  K

• Selecteer eventueel Open this network place when I
Uw website wordt geopend in een Windows verkenner-
wordt gevraagd in te loggen.  U kunt nu eenvoudig b
website kopiëren. 
U kunt deze methode ook gebruiken om bestanden naa
het is verstandiger om dat altijd via FrontPage te doen. 
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Hyperlinks en e-mailadressen ‘sne
Als u externe hyperlinks wilt invoegen in uw site, kunt
dialoogvenster 

l’ invoegen 
 u dat doen met behulp van het 

re methode werkt als volgt: 

. 

en. 

n het adres en geef een spatie. 
nk.  Vervolgens kunt u de tekst van 

k wenst.  Eenzelfde truc kunt u 

enen, dan moet u dat nog wel apart 

et plaatjes 

ers. 

ikt 

dt. 

t 
te bovengrens is.  Maar 

er z

Voor de de richtlijnen (maar niet 
dwi e

• ebruiken we afbeeldingen van 120 bij 160 pixels, die gemiddeld 

• 
en. 

yte (en 
 te vermijden). 

Insert Hyperlink (zie pagina 9).  Een snelle

• Kopieer het adres van de pagina uit uw browser

• Gebruik Paste Special om dit in uw tekst te plakk

• Plaats de cursor achter het laatste teken va
FrontPage maakt nu van het webadres een hyperli
het webadres vervangen door de tekst die u als hyperlin
gebruiken voor e-mailadressen. 
Als de nieuwe link in een specifiek frame moet op
instellen. 

Pas op m

GIF, JPG, of nog iets anders? 
Gebruik alleen plaatjes van het type GIF of JPG (jpeg).  Het type PNG wordt door een 
aantal browsers inmiddels ook weergegeven, maar nog lang niet door alle browsers.  
Andere afbeeldingstypen worden niet (goed) weergegeven door de meeste brows

Of u GIF of JPG moet gebruiken hangt af van het type afbeelding.  Voor foto’s gebru
u JPG.  Schematische afbeeldingen kunnen meestal als GIF worden uitgevoerd.  
Algemene tekenpakketten zoals Photoshop, Paintshop Pro en Corel hebben 
tegenwoordig tools waarmee u afbeeldingen voor het web kunt optimaliseren.  Deze 
tools kunnen vaak laten zien hoe groot een plaatje in bytes wor

Wat is groot? 
Zorg er voor dat afbeeldingsbestanden niet te groot zijn.  Er zijn geen vaste regels voor, 
want een en ander wordt uiteraard ook door de context bepaald.  Als er veel 
afbeeldingen op één pagina verschijnen, dan moeten die afbeeldingen niet al te groot 
zijn. 
Een stelregel kan zijn dat een webpagina, inclusief al het beeldmateriaal normaliter nie
meer dan 25 kilobyte mag beslaan, en dat 100 kilobyte de absolu

ijn altijd uitzonderingen op de regel mogelijk. 

 faculteit Bètawetenschappen hanteren we de volgen
ng nd): 

Voor pasfoto’s g
zo’n 5 kilobyte groot zijn. 

Foto’s worden zodanig verkleind dat de lange zijde maximaal 300 pixels 
bedraagt, en ze maximaal 20 kilobyte groot word

• Achtergronden van webpagina’s mogen niet groter zijn dan 10 kilob
liever proberen we het gebruik van achtergronden helemaal
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Achtergrond: opzet van de webservices 
In dit hoofdstuk geven we wat uitleg bij hoe een webpagina in elkaar steekt en
hoe een webserver werkt. 

 

De web erver.  De pagina’s staan op 
een m  met een browser naar de 
web e

.  

L te kennen.  FP2003 zorgt er voor dat opmaak of bijvoorbeeld een link 
worden vertaald naar HTML. 

rdt niet alleen bepaald door de HTML-code in de pagina, 
maar ook door een stylesheet (zie ook het onderdeel ‘Stylesheets’ verderop). 

e 

hoofdonderwerpen op de site, plus links naar 
n’ en de ‘sitemap’ (een 

 die de bezoeker ziet, zijn in totaal dus vijf pagina’s nodig: 
een  
worden

Webs
Alle e
beetje eld 
dat er voor zorgt dat de bezoeker de juiste dingen krijgt te zien. 

Een webserver is altijd gekoppeld aan een webdomein.  Het domein kunt u terugzien 
in het webadres (ook wel URL genoemd) van een webpagina.  Het is een naam gevolgd 
door een zogenaamd topdomein.  Bijvoorbeeld, het domein van de Universiteit Utrecht 
is uu.nl.  Hierin is het stukje .nl het topdomein; u vindt dat topdomein terug bij alle 
websites die in Nederland geregistreerd zijn.  De meeste landen hebben zo’n 
topdomein.  Zo staat .uk voor het Verenigd Koninkrijk, .de voor Duitsland, .be voor 
België en .fr voor Frankrijk.  Er zijn ook topdomeinen die niet aan een land maar aan het 
soort website zijn gebonden.  De bekendste is wel .com (‘dot com’) dat voor 
commerciële doeleinden wordt gebruikt.  De topdomeinen .org en .net kunnen worden 
gebruikt door allerhande organisaties en individuen.  

sites van Bètawetenschappen draaien op een webs
 co puter, en de webserver zorgt er voor dat iemand die
sit  gaat, de juiste pagina’s krijgt te zien. 

Webpagina’s zijn geschreven in een code die HTML heet: HyperText Markup Language
Met HTML-code kunt u bijvoorbeeld tekst vet of cursief maken.  Links naar andere 
pagina’s worden ook door middel van HTML gemaakt.  Daarnaast kan er in HTML nog 
allerlei extra informatie over een pagina worden gezet, zoals wie de pagina heeft 
gemaakt en met welk programma.  Om een pagina in FP2003 te bewerken hoeft u zelf 
geen HTM

Het uiterlijk van een pagina wo

Frames 
De pagina’s van Bètawetenschappen zijn opgezet als zogenaamde frames.  Dat wil 
zeggen dat de bezoeker steeds een pagina krijgt te zien die is opgebouwd uit meerder
stukken.  De ‘kop’ en de ‘staart’ zijn altijd 
hetzelfde.  In de kop, bovenaan elke pagina, 
staat het beeldmerk van de UU, de Sol, en het 
‘logo’ van Bètawetenschappen.  In de staart, 
onderaan elke pagina, staan links naar de 

‘printen’, ‘zoeke
algemene pagina die een beschrijving geeft van 
de site).  Tussen de kop en de staart staan een 
navigatiebalk en de feitelijke inhoud van de 
webpagina. 
Hoewel men als bezoeker maar één pagina lijkt 
te zien, kijkt men in werkelijkheid naar vier 
verschillende pagina’s, die in één raamwerk 
worden getoond.  Het raamwerk wordt een 
framepage genoemd, en de onderdelen heten 
frames.  Voor één pagina

tje waarin het raamwerk wordt ingericht, en vier pagina’s die elk in een frame 
 getoond. 

ervers en domeinen 
 w bpagina’s staan op een computer die de webserver wordt genoemd.  Een 

verwarrend, want met ‘webserver’ wordt ook het computerprogramma bedo
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Terug naar het webadres.  De domeinnaam bepaalt dus in eerste instantie waar een 
m een website 
n de faculteiten 

en dive
ondersc innaam nog één of meerdere termen te zetten.  Voor 

) 

de 

eel 

n zien 
illende subdomeinen bevatten. 

faculteit/ 
verwijst naar een webpagina op de webserver van Bètawetenschappen die gaat over ‘de 

ijn browser of klikt op een link in een pagina 

ffende pagina is te vinden, en legt 
. 

e betreffende pagina horen 
eze op op de computer, en stuurt ze 

 eventuele stylesheets), bepaalt aan de 
ien, en toont het resultaat aan de 

ook kijken of de opgevraagde pagina 
ewaart namelijk (meestal) een kopie van 
t, op de computer van de bezoeker.  Als de 
ina wil waarvan kort tevoren al een kopie 

De bezoeker kan dan dus een 
 

na is 

Zelfs dat is niet altijd genoeg.  Met de functietoets <F5> krijgt u altijd de meest recente 
an kan het nog mis gaan, vooral als u naar een 

n, 

 
voor 

.  De Remote Web site staat op de 

website thuishoort.  In principe is de domeinnaam dan ook voldoende o
aan te geven.  In de praktijk is dat echter niet genoeg.  Bij de UU hebbe

rse onderdelen allemaal hun eigen website(s).  Die worden van elkaar 
heiden door vóór de dome

de hoofdsite van de UU is dat www: www.uu.nl .  De faculteiten krijgen er meestal een 
(Engelse) term bij: www.phys.uu.nl (voor ‘Physics’) of www.chem.uu.nl (voor ‘Chemistry’
of www.law.uu.nl (voor ‘Law’, Rechten). 
Maar ook het stukje voor de faculteitsaanduiding is niet vastgelegd.  Zo kent men bij 
natuurkunde een www.phys.uu.nl en een www1.phys.uu.nl, die elk naar verschillen
websites verwijzen. 

In het algemeen geldt: als er vóór de domeinnaam iets staat, dan wordt dat als geh
een subdomein genoemd.  Ieder subdomein verwijst naar een specifieke webserver.  Een 
subdomein kan nooit naar verschillende webservers verwijzen, maar zoals we zulle
kan één webserver wel versch

Alles wat in het webadres ná de (sub)domeinnaam komt, is bedoeld om op die 
specifieke webserver iets aan te duiden.  Bijvoorbeeld: www.science.uu.nl/de

faculteit’. 

 
De normale gang van zaken bij het opvragen van een webpagina is als volgt: 

1. Een bezoeker vult een webadres in in z
die hij of zij bezoekt. 

2. De browser kijkt op welke website de betre
contact met de webserver van die website

3. De webserver kijkt welke bestanden er bij d
(bijvoorbeeld plaatjes en stylesheets), zoekt d
terug naar de browser. 

4. De browser interpreteert de HTML-code (en
hand daarvan hoe de pagina er uit moet z
bezoeker. 

Om het werk wat te versnellen kan een browser 
kort tevoren ook al is bezocht.  De browser b
een bezochte pagina, en alles wat er bij hoor
browser denkt dat de bezoeker naar een pag
is gemaakt, dan laat de browser de kopie zien.  
verouderde versie van de pagina te zien krijgen.  Het is daarom ook verstandig om de
browser zo in te stellen dat er in ieder geval altijd wordt gecontroleerd of een pagi
vernieuwd. 

versie van een pagina te zien.  En zelfs d
pagina met frames kijkt.  Met <F5> wordt namelijk de framepagina opnieuw gelade
en niet, of niet altijd, de pagina’s in de frames.  Een paar keer <F5> achter elkaar kan 
helpen. 
 

De pagina’s op de site van Bètawetenschappen hebben meestal logische namen.  De 
pagina waarin de frameset wordt gemaakt heet index.html, de pagina met de 
navigatiebalk heet nav.html en de pagina met de inhoud heet cnt.html.  De pagina’s die
de kop en de staart bevatten staan op een algemene plek die alleen toegankelijk is 
de beheerder(s) van de site. 

Publiceren 
Bij Bètawetenschappen zijn de meeste websites ‘dubbel’ uitgevoerd.  Er is een website 
op de ontwikkelserver en eentje op de productieserver
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ontwikkelserver en is bedoeld om op te werken.  Hier kunt u uw webpagina’s aanpas
en controleren, voordat u ze aan de hele wereld toont.  De Local Web site staat op de 
productieserver en is de plek waar de reguliere bezoeker naar kijkt. 
Anders gezegd: de ontwikkelserver is de werkplaats, de productieserver is de e

De ontwikkelserver wordt ook wel stage genoemd, en de productieserver wordt ook wel 
de www genoemd.  Dat is ook terug te zien in de naamgeving.  De website op de stage 
heeft dan als adres bijvoorbeeld stage.science.uu.nl/website, terwijl de website op de 
www het adres www.science.uu.nl/websit

sen 

talage. 

e heeft. 

den er gekopieerd 

 de logfiles, die u op de tab Remote Web site kunt openen, kunt u zien welke bestanden 

een wikkel- en productieserver zoveel mogelijk 

ver

St
, 

ma a’s 
wordt bekeken, en waarin bijvoorbeeld staat wat voor lettertype er op een pagina 

n 

nen voorkomen dat er voor uw website een apart stylesheet wordt 
emaakt.  Dit wordt dan onderdeel van uw website, zodat u zelf het beheer daarover 

Hoewel dit verschillende adressen zijn, staan de bestanden overigens wel op dezelfde 
computer.  Dit is dus zo’n geval waarin één webserver verschillende domeinen bevat. 

Om uw website van de ontwikkelserver naar de productieserver te krijgen, moet u de 
website publiceren.  De bestanden op de stage worden daarbij gekopieerd naar de 
www. 

FrontPage gebruikt een aantal foefjes om te zien welke bestan
moeten worden.  Meestal, maar niet altijd, worden alleen die bestanden gekopieerd die 
ook daadwerkelijk zijn veranderd.  Een enkele keer raakt FrontPage de weg kwijt, 
vooral als er meerdere mensen aan een website hebben gewerkt.  Dat kan dan 
resulteren in foutmeldingen zoals die op pagina 13 worden behandeld. 

In
er zijn gekopieerd. 

FrontPage kan ook opmerken dat er op de remote web site bestanden staan die niet op 
de local web site staan.  Het kan bijvoorbeeld zijn dat u bestanden hebt verwijderd of 

 andere naam hebt gegeven.  Om de ont
identiek te houden, kan FrontPage dergelijk bestanden van de remote web site 

wijderen. 
U kunt ook aangeven dat bestanden niet gepubliceerd mogen worden. 

ylesheets 
Het uiterlijk van een pagina wordt niet alleen bepaald door de HTML-code in de pagina

ar ook door een stylesheet.  Dat is een algemeen bestand dat door alle pagin

wordt gebruikt, of in welke kleuren de pagina wordt getoond.  Het stylesheet wordt 
normaliter alleen bewerkt door de beheerder(s) van de site. 

Een stylesheet maakt het mogelijk om de pagina’s binnen een site allemaal een min of 
meer gelijk uiterlijk te geven.  Bovendien kan dat uiterlijk op eenvoudige wijze worden 
aangepast.  Als bijvoorbeeld de achtergrond kleur van de tekstpagina’s op de website 
van Bètawetenschappen zou moeten worden aangepast, dan hoeft er maar één regel in 
één stylesheet te worden veranderd. 
Een webpagina kan meerdere stylesheets hebben.  Daarbij wordt de meest algemene 
stylesheet het eerst aangeroepen.  Deze techniek maakt het mogelijk om een pagina 
een algemeen stramien te geven, maar met kleine aanpassingen.  Op deze manier 
kunnen we een pagina maken in de huiskleuren van Bètawetenschappen, maar met ee
afwijkend lettertype. 

zou kunHet 
g
kunt houden. 
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